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Do you have students in your class who...

have a variety of academic abilities?
have different educational experiences?
nave different backgrounds?

have different learning styles?

have different preferences?
are used to instruction at different paces?
have a disability?




The average student is a myth
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Universal Design for Learning (UDL)

» an educational framework to guide development
of flexible learning environments

to accommodate individual learning differences

+» seeks to increase access to learning
by reducing physical, cognitive, intellectual
and organisational barriers




The two aspects of UDL

= a conceptual model from which a set of
principles and practices are derived

= a set of specific practices and guidelines by
which universal design is actually
accomplished




UDL Principles and Guidelines

Principle I. Multiple Means of Representation
= Guideline 1: Provide options for perception

= Guideline 2: Provide options for language,
mathematical expressions, and symbols

= Guideline 3: Provide options for comprehension

CAST: Center for Applied Special Technology




UDL Principles and Guidelines

Principle Il. Multiple Means of Action and Expression
= Guideline 4: Provide options for physical action

= Guideline 5: Provide options for expression and
communication

s Guideline 6: Provide options for executive functions

CAST: Center for Applied Special Technology




UDL Principles and Guidelines

Principle Ill: Multiple Means of Engagement
= Guideline 7: Provide options for recruiting interest

= Guideline 8: Provide options for sustaining effort
and persistence

= Guideline 9: Provide options for self-regulation

CAST: Center for Applied Special Technology




UDL, but.....

= Few studies have provided a comprehensive
framework to put the UDL pieces together,
In a practical, research grounded & efficient way [1]

= UDL is much more complex than we originally
thought [2]

[1] Katz, J. (2013), Canadian Journal of Education, 36, 153-194
. [2] Edyburn D. (2010) Learning Disability Quarterly, 33, 33-41




The UDLnet project

UDLnet i)

" . Universal Design for Learning
Aims: * ’

= to bridge the gap between policy and practice in
applying UDL

= to address the necessity of collecting and creating

UDL good practices from a wide range (educational,
cultural, language, etc.)

UDLnet targets 2.000 users all around Europe and internationally

1D http://www.udInet-project.eu/



Inventory of UDL Good practices (1/2)

= developed under the UDLnet project

= a collection and categorization of UDL.:
¢ Good Practices,
¢ Media Resources,
o Collections




Inventory of UDL Good practices (2/2)

aims to support diverse learning communities to:
a) find,
exchange,
adapt,
teaching or learning practices

b) feedback from actual UDL implementation
In classrooms




UDLnet Inventory includes:

Media Resources: complement the UDL Good
Practices and relate to the pedagogical approach
applied by the educationalist and the instructional
material used

Collections: provide UDLnet users with the facility to
gather, link, and organise different Good Practices
and Media Resources together to meet their specific
needs around a particular topic, theme, or class




Basic facilities of UDLnet Inventory

browse / search (by topic, keyword, edu level, language),
create,
adapt,
assess / evaluate:
UDL practices,
UDL media resources,
UDL collections,

UDL based lesson plans,
UDL educational scenarios.
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UDLnet Inventory

target users:
— teachers,
— teacher educators,
— educationalists,
— professors,
— practitioners,
— policy makers,
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Universal Design for Learning

Home Good Practices Media Resources Collections Community Documentation  About

Universal Design for Leaming (UDL) is an educational framework to guide development of flexible
learning environments to accommodate individual learning differences. UDL seeks to increase access
to learning by reducing physical, cognitive, intellectual and organizational barriers.

This site (developed under the UDLnet project) aims to provide a comprehensive Inventory of UDL
Good Practices to benefit the interested users in the field (educationalists, teachers, professors,
practitioners, etc.). We point out that UDL is not something completely new for the learning providers,

as in many cases they apply UDL unconsciously.
Contributors are invited to record their Good Practices here based on their UDL experience and

practice.

UDLnet Inventory Facilities

Benefits of Using the UDLnet Inventory

Myths and Misconceptions about UDL

Suagestions for the UDLnet newcomer




Media Resources Collections Community Documentation Abo

GDGd PraCtiCES Sort by Title (asceding Results per page




Filter Good Practices
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Communication Dutch
Technologies) Finnish
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Physical Greek
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Social Studies ltalian
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+ Creating Accessible Documenis bl iess Crersll rating: 5.0/ 5

Upload =>eorgios Kouroupetroglou, University of Athens, Greece Rated: % 4 % * %

Overview School Context UDL in Action Media Resources Skills and Competencies Ascessment

Evaluation / Comments from Users

Author: Georgios KO LLlniversity of Athens, Greece Copyright: E
Date Modified: 2015-12-20

Short Intro:

This UDL Good Practice provides guidelines to the MS-Word users (versions 2007, 2010, 2013 or 2011 for MAC) in order fo create accessible documents, ie. ¢
that can be efiiciently used by more studenis (including those with sensory, physical, mental or learning disability) in more usage cases (e.q. with small screen
smartphones or tablets, or with Assistive Devices like a screen reader).

The guidelines in this Good Practice follow the Design for All approach and are provided in multiple ways: short versions, long versions, slide presentations, as
video tutorials.

The guidelines can be applied: a}in all kind of documents (e.g. teaching notes, books, or examination themes) and b) for the creation of new documents or the
modification of existing ones.

Intended Objectives | Outcomes:
To provide to the authors (teachers, professors, educators, etc.) practical guidelines in various forms (short, long, slides, videos) for the creation of accessible e
documents using M3-Ward (version 2007, 2010, 2013, or 2011 for MAC).

Ten myths on the accessibility pf educational documents:

1. Every electronicfile (e.g. MS-Word, PDOF) is accessible.

2. Accessibility refers only the students with disahbilities.

3. ltis hard and complex to achieve accessibility in documents.

4. Accessible documents are boring and low aesthetics.

5. Students with disahbilities will not read my documents.

6. |have totarget on the majority, most of the students are not disabled.

7. There is notone to force me to produce accessible documents.

8. |have to create another version of my documents which will be accessible.
8. |have to put a lot of effort to create accessible documents.

10. Finally, | would not have any benefit from the accessibility of my documents.

A study of Forrester Research, Inc. ordered by Microsoft, showed that 57 % of the computer users benefit directly or indirectly when accessibility has been applie

Main Topic: Cther



« Building Vocabulary: "The Monkey's Paw™

Katerina Riviou, Ellinogermaniki Agogi (EA), Greece Fated:

hool Context UDL in Action Media Resources Skills and Competencies Assescment

ments from Users

Author: Katerina Riviou, Ellinogermaniki Agogi (EA), Greece Copyright: @ (1)&5(0)
Date Modified: 2015-05-08

Short Intro:

Learners often struggle with classic literature because of the vocabulary demands—some words are archaic and some are above grade level
for today's students. This vocabulary lesson is for use bhefore students begin the shaort story, "The Monkey's Paw”. The lesson uses words from

this classic story to support vocabulary growth and increased reading comprehension.

BY MO SA

Intended Objectives / Outcomes:

Students will be able to determine the meaning of words and phrases as they are used in the text, including figurative and connotative
meanings.

Main Topic: Languages

Secondary Topic: Language Arts

Target Groups: Secondary education (14-15 age old students), could be adapted for use in primary as well

Keywords: vocabulary, classic literature

Educational Level: Secondary

Language: Enaglish

References:
CAST 2006: link

UDL Exchange: link




- Creating Accessible Documents with MS-Word

Uploaded by: Geo[ghe-s=temrres froglou, University of Athens, Greece Fated: 4 # 4 % &

UDL in Action Media Resources Skills and Competencies

Assessment on f Comments from Users
Resources [ Environment:

For this Good Practice users must have access to a personal computer with the MS-Word word processor (version 2007, 2010,
2013, or 2011 for MAC).

Barriers and Opportunities:
Applying the MS-Ward accessibility guidelines in existing documents, may be time consuming. In contrast, when the MS-Word
accessibility gquidelines are applied during the creation of new documents the required extra time is substantially shorter.

The 2010 and 2013 versions of M3-Ward include an accessibility checker toal.
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+ Creating Accessible Documents with MS-Word Cvarail rating

Uploaded by: Georgios Kouroupetroghee? University of A Greece Fated: 4 # % # &

Overview School Contex UDL in Action Media Resources Skills and Competencies

Assessment Evaluation / Comimes

UDL Principle: Learners are e d and motivated in different ways

Guideline: Different known interests and motivators are addressed such as ...
* choice in context

Guideline: Interests and goal attainment as well as resilience are stimulates actively by ...
« practical relevance

Guideline: There are opportunities for self-regulation provided ...
« creative freedom
« organizational flexibility

UDL Principle: Information/Instruction offered in different ways
Guideline: Relevant information is available on the learning objectives and outcomes
* inadvance
« atany time
« on demand

Guideline: Information can be assimilated in various ways
« visual

Guideline: The understanding/comprehending of information is supported by providing various options
« llustrations
« practical demonstration

UDL Principle: Allow the learners to express what they know in different ways
Guideline: Learner can actively work with the learning materials in different ways
« individual worl
* group work

Guideline: Learners can show the results of work as ...
« textual description
« practical demonstration

Guideline: There are different forms of support provided such as ...
« formative (self) assessment
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Uploaded by: Georgios Kouroupetroglou, University of Atheng

yle Documents with MS-Word vers

Overview School Context UDL in Action Skills and Competencies
Assessment Evaluation f Comments from Users
Title:

Media type: Document
Description: Short guidelines for creating accessible documents with Word 2007-2010

Title:
Media type: Document
Description: Short guidelines for creating accessible documents with Waord 2013.

Title:
Media type: Document
Description: Short guidelines for creating accessible documents with Ward 2011 for MAC.

Title:
Media type: Presentation
Description: Slide presentation on the Eight Steps for creating accessible MS-Word .documents.

Fated: 4 4 o o




+ Whole class participation in a pancake cooking task and sequencing the steps

Uploaded by: Neil O Sullivan, Universal Learning Systems, Ireland Fated: 4 4 o 4 &

Overview School Context UDL in Action Media Resources Skills and Competencies

Assessment Evaluation f Comments from Users

Demonstration of partnerships and collaboration: Medium

More detail:

Lesson and media resources were accessed for school resources. Extra resources were returned to central resource area after
lessons.

Facilitation of student learning: High
More detail:
This lessan achieved its goals form a UDL perspective.

Assessment and reporting student learning outcomes: High
More detail:
The feedback both form formative and summative assessment was satisfactory.

Demonstration of continuing professional development: Medium
More detail:
The teacher found the process useful and shared her experience with other teachers in the school.




+ Whole class participation in a pancake cooking task and sequencing the steps involved Overall rating: 5.0/5 (basad on 1 usar)

Uploaded by: Meil @ Sullivan, Universal Learning Systems, Ireland Fated: 4 4 4 % pdf ope

Overview School Context UDL in Action Media Resources Skills and Competencies

valuation f Comments from Users

= [ WaT=N
The benefits of the use of this UDL best practice were the following:
The task was fun and active.

The children engaged all of their senses during the lessons.

How were outcomes and outputs evaluated and/or assessed?

2 Through observing the children engage with this lesson topic thereafter (e.g through play/SESE) enabled the teacher to gain
access to the pupils’ understanding of the topic.

O Assessmentwas given orally.

O Diffierentiated questioning e.g

Higher Crder Questions:
2 Why do you think the pancake batter thickens when | add flour?

2 What do you think would taste really nice with the pancake?

Lower Order Questions:
What steps do | take to make the pancake mix?
What do | putin next?

How were lessons learnt and competences obtained?

2 The students obtained knowledge about the procedure by using different senses. The variety of communicating methods
sensitized the students, i.e. they were able to concentrate and memorize the sequence.

2 The process required social skills as well. The students learnt to take turns in providing suggestions for instructional writing
and tasting pancakes, share resources, respect each other's individual efforts. Language and communication skills were
extended too (e.q speakernlistener respect, exploring the genre of procedural literacy).

Feedback / Reflection:

How was reflection on this best practice shared?

-Mediation to whole staff through the school's main staff server (in English resource file).
-Staff planning meetings.
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* Anupioupyia Tpoofdoigou exTraideutikol uhikol pe yphAan MS-W

Avapnke amd: Georgios Kouroupetroglou, University of Athens, Greece BoBpohoyia:

Mokupedkoi Mopo AEEIOTNTEG KOl IKOVOTNTEC

Afiohoynan [ Ixoha amd Toug XpRoTeg

Evlampia

H "u--m\rlué-.-n KCIAR TIDOKTIKS TIQOYUCTOTIONE TOV TIRWTERKIKO OTOX0 TRC, TIoU apopd TNV TapoXn RO TOUC TUYYPOREC
(BOoKIhoUC, KOBNYNTEC, EKTIAIBEUTIKOUG, KATT) TUNTOULY KOl OVOAUTIKWY TTRaKTIKWY oGnyiwy yia tn Gnuioupyia mpoopdmpou
ekTRnGEUTIKO 0 UAIKOO JE To MS-Word. Akdun omoTekel EQTIDAKTT ERAPUOYA Kol EMGEIENC TROTIWY OTTOTERESUOTIKAC ¥pranc Tou
mhaigiow TR KEM ko avabakvOe Tn BuvardTnTa Tng Suvapikng Tou eKTrafeuTikod TTEpIEXOPEVOU UTTO TO TIpioua Tno KEM,
GivovTtag TN GuvaTdTnTa of ek BeuTikoOc, aBnTEC, YOVEIC KOl Ghha JEAN TNC KOVGTNTAC VO avainTRooUy Kal v
Tpogapubgouy TpooRdgIPo EXTRNGEUTIKG TTEPIEXOUEVD. AVTOTIOKMIV ETal cm; |“’ ITIKEC :urx'é-g NG OXEGIQONE YIa OAOUC KOl TNG
kaBohknc axeliaanc TnC paBnang, TIC 0TI0IEC KOl EpapUATEl Kol |2 Jan, akhd Oyl O OAEC TIC TIEQITITIOGEIC £E' ohoKARpoU. Ba
pTTpoOoE oTov ToWEa TN "Napoxic Meéowy Apdong ko Exppdonc” yia ToU, EKTTOBEVOUEVOUC VO EYTIAOUTIOTE! JE TIEpIOTOTEDES
EMADYEC TIOU VI CNTOTTOKPIVOVTO WE T TO TIAEIGTOV OTa 600 oYETIKG TpoTdogovTal amd tn UDL.

Mapic
Tooo ol avahUTIKES 000 Kol o ovToWEC obnyieg yia T Gnuoupyic |rrn"r IOV KEIMEVWY JE TO MS-Word 2010 Bewpid TG
gival 15IaiTEpa BonBnTIKES KOl KOTOTOTOTIKES TOOO VIO Ap¥IpI0UC GO0 KOl yIg TTROXWRNUEVOUS ¥pRaTeC | Uy DOREC
TpooRdopou kTG euTIKoU ukikoO (Baokakoug, KaBnynTeg, ekTmBeumikos, KATT), KaBwe Givouv AETTOPERES Brga Tpog BApa
ofnyies yia 10 TEpIEXOUEVD, TN GoUM KOl TO GAAD TUCTATIKG PEpn Tou Eyypdpou (CUvBETEIC, OVTIKE JEV, THVIKES, KATT) JE TN
¥pRon AEKTIKAC TTEQIVRQ@NC OF CUVGUDOUO JE TNV OTITIKA OTTEIKOVION BOOIKWY EVTOMUY TIOU EKKIVO OV OTTd T "Ypapun pevod” Je
TIC OVTIOTOIKEC EMAOYEC OF KABE KapTEAD. ETTONC, 01 CUTTAOEIS KOl 0 EAEYXOC TTROORATIHOTATAL TOW KEIWEVOU TTOU EMTTEQIEX OVTOI
gautec TIC 0bnyieg, cupBahkouy aTn GlaoEahion TNG 10OTINNG TIPOCROONC YO OAEC TIC KOTNYOPIEC ¥pnOTWy
CUUTTERIAIM POVO LEVOU TWW aTOUWY JE OVOTINpia aTo Lunf*rlm TEQIEXOUEVD, KB JECW aUTWY aTToTpEToyTal EvBEXDUEVT AGEn
GUVOVTOI VO OTTOKAEITOUV ¥pROTES OUYKEKDILE KOTMYOpIWY avamnpiag (.. dropga Je mpophApara dpacnc).
Algmamoveral Aoimdy, 0TI o1 obnyies autég Exouv oxeliaoTe BAoe Ty apxwy Tng KaBokikng Zxebiaong Tne Madnong, kadwe
UTRIpEl EVEAIEID OTOV TROTIO TTOU TTapOUmAioNTal o TTANpo@opies, EVL TRIpAAANAT N EYTTPAKT EK TWV TTROTEQWY EQOpUOYT
Glo@dpuv TPOTILOY OVATApdaTaon ¢ TwWV TTANPOQOILY SUVTEADDY aTn BIGCEahITn TNG TROTRAS UATNTAC OAUY TWV ¥pM o,

ITéhha

MEgw auTthg TI'|., KIAAC TIPOKTIKAC EIVE ELPaVES TIWE N uEh:u \Kr Tyedican pasnang Gev ameuBOvVETal JOVO OTa ATopd JE
OVOTINRIeC ChAD EKTTANPUVE TOUE OTOX0UE TN SNUIoupyuvTag TRooRAoIUo ukikd ammd To omoio Emwgeho vTa dAol o1
ekTRnGevopevol. H Tapougiadn TN o8 oUNToun akhd Kal avahuTIkh Jop@n Sniwve Twe Sev amoTehe o S00Kokn Kal Emimovn
Epyagia akhd pia euxdpiotn Siadikagia THoo yia Tov EM”II._.EL'TIN:I OO0 KOl IO TOV EKTTNSEVD UEVD. SEwpL ADITTOV THWE 01 ap¥IKoi
OTOY0! KOAJTITOVTOl ahhkd UTTdpxouy TTEpIBWRIa PeATIWONG 000 EEENTOETM M TEXVOADYIO KOl QUEIVONTOI 01 EMAOYES TTOU JOC
TpOGQEDEL

XPYEZOYAL
MpOKETD TTRAYUAT! YIA JIa TTRAKTIKA TToU aTRRIfETal OTI¢ apxE TNC KaBokknAc ZxeGiaonc. Kupiwg, EMIXEIPE va TTOpExel aToug
CRTIIIAELMIEO T YORMIIEr TTAROOMOnIcr BTE Wil VIVEl Ta svvndnmn Tot M2 Word TTooadRoio v ok ol
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Basic selection criteria for
a UDLnet Good Practice

s transferable
= adaptable
s flexible

n effective




Other UDLnet Inventory facilities

= my UDL Good Practices

= my favorites UDL Good Practices

= my UDL Media Resources

= my favorites UDL Media Resources

= my Collections of UDL Good Practices

= my favorites collections of UDL Good Practices




Inventory offers to the UDL newcomer

= UDL online course (free)

= UDL multimedia book (free)

= Quick reference UDL card

s Reference publication

= Link to UDL Guidelines Ver. 2.0

= Myths and Misconceptions about UDL




Benefits of using the UDLnet Inventory (1/2)

= Diverse UDL techniques, methods and resources
available as a comprehensive and growing repository.

s Users can access and modify concrete examples of
UDL Good Practices on a range of topics.

= Support and supply enough scaffolding to newbies in
the field of UDL and inspire more advanced users.




Benefits of using the UDLnet Inventory (2/2)

s Users can be connected and collaborate with peers
on UDL, even for a specific Good Practice or at a
national level.

s Decreasing preparation time for UDL based lessons,
while keeping high quality.

= Bottom-up Continuing Professional Development.




The UDLnet Inventory of Good Practices

= has not been designed as a destination but as a
forum for self-reflection and critical thinking

= It is rather an evolving space where:
o practices > mutate, shaped and altered,

o results > are fed back into the qualitative
learning loop




The UDLnet Inventory of Good Practices

s not static,

= a growing and dynamic space whose main
purpose is to:

¢ stimulate new reasoning on UDL practicies,
¢ challenge existing UDL practices.




Example of a UDLnet good practice
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+ Creating Accessible Documents with MS-Word

Uploaded by: Georgios Kouroupetroglou, University of Athens, Greece Fated:
Overviev School Context UDL in Action Media Resources Skills and Competencies
Assessment Evaluation /f Comments from Users

Author: Georgios Kouroupetroglou, University of Athens, Greece Copyright: |@ G}@@|

Date Modified: 2015-12-20

Short Intro:

This UDL Good Practice provides guidelines to the MS-Word users (versions 2007, 2010, 2013 or 2011 for MAC) in
order to create accessible documents, i.e. documents that can be efficiently used by more students (including those
with sensory, physical, mental or learning disability) in more usage cases (e.g. with small screen devices like
smartphones or tablets, or with Assistive Devices like a screen reader).

The guidelines in this Good Practice follow the Design for All approach and are provided in multiple ways: short
versions, long versions, slide presentations, as well as video tutorials.

The guidelines can be applied: a} in all kind of documents (e.g. teaching notes, books, or examination themes) and b)
for the creation of new documents or the modification of existing ones.




+ Creating Accessible Documents with MS-Word

Uploaded by: Georgios Kouroupetroglou, University of Athens, Greece Rated: pdfi open
Overview School Context UDL in Action Media Resources Skills and Competencies
Assessment Evaluation / Comments from Users

Intended Objectives | Outcomes:

To provide to the authors (teachers, professors, educators, etc.) practical guidelines in various forms (short, long,
slides, videos) for the creation of accessible educational documents using MS-Waord (version 2007, 2010, 2013, or
2011 for MAC).

Ten myths on the accessibility pf educational documents:

Every electronic file (e.g. MS-Word, PDF) is accessible.

Accessibility refers anly the students with disabilities.

Itis hard and complex to achieve accessibility in documents.

Accessible documents are boring and low aesthetics.

Students with disabilities will not read my documents.

| have to target on the majority, most of the students are not disabled.
There is not ane to force me to produce accessible documents.

| have to create another version of my documents which will be accessible.
. I have to put a lot of effort to create accessible documents.

0. Finally, | would not have any benefit from the accessibility of my documents.

1.
2.
3.
4.
5.
6.

= L0 09

A study of Forrester Research, Inc. ordered by Microsoft, showed that 57% of the computer users benefit directly or
indirectly when accessibility has been applied.

Main Topic: Other

Secondary Topic: Generic or horizontal (can be applied in all topics)
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+ Creating Accessible Documents with MS-Word

Uploaded by: Georgios Kouroupetroglou, University of Athens, Greece Fated:

Overview School Context UDL in Action Media Resources

Skills and Competencies

Assessment Evaluation / Comments from Users

Target Groups: The accessible educational documents targets mainly students with sensory, physical, mental or
learning disahility of all ages or educational levels in all forms of learning (education, training, etc ).

Keywords: accessible educational documents, MS-Waord, accessibility, design for All
Educational Level: All
Language: English

References:

1y Short Guidelines:
Creating accessible docs with Word 2007-2010 link
Creating accessible docs with Word 2013 link
Creating accessible docs with Word 2011 for MAC link
Howto make a Word document accessible link

Guidelines for creating Accessible Documents:
Creating accessible docs with Word 2007 link
Creating accessible docs with Word 2010 link
Creating accessible docs with Word 2013 link
Creating accessible docs with Word 2011 for MAC link

3) Slide presentation: Eight Steps To Accessible Waord Docs link

4)  Tutorial videos:
* Creating Accessible Documents with Microsoft Word 2013 link
« Creating Accessible Documents with Microsoft Word 2010: Part COne link
* Creating Accessible Documents with Microsoft Word 2010: Part Two link




CREATING ACCESSIBLE MICROSOFT WORD 2013

DOCUMENTS (WINDOWS)

Heading Styles

Create a unzform )'Jeﬂdz'ng structure tbroug/; use of st_yles

in Word. This allows screen readers to navigate a document
and improves accessibility for everyone.

Adding and Editing Headings
1. Select the text and choose the appropriate style under
Styles on the Home ribbon. (e.g., “Heading 17)

2. Headings 1, 2, or 3 can also be assigned using CTRL +
ALT + 1, 2, or 3, respectively.

AaBbCcDc AaBbCcDc AaBhC( A | aseoced AQB| -

fNormal T No Spac.. Headingl @ Heading2 @ Heading3 Title =

Styles ]

Lists

Use true numbered and bulleted lists to emphasize a point
or a sequence of steps.

Creating Lists

1. Select the Numbered List or Bulleted List option on
the Home ribbon, under the Paragraph section.

Alternative Text for Images

Images can be given appropriate alternative text in Word.
This alt text is read by a screen reader in a Word file and
should remain intact when exporting to HTML or PDE

Adding Alt Text Format Picture s
1. Right-click on the image and | 2,
choose Format Picture.

2. Select the Layour & it
. . 4 ALT TEXT
Properties icon and choose =
Alr Text.
3. Enter appropriate alt text Descnption
only in the Description field ALTERNATIVE TEXT HERE

(not the Title field).

Columns

When creating columns, always use true columns, not
columns created by hand with the Tab key.

Creating Columns

1. Select Page Layout on the ribbon.

2. SCICC( CD[[‘T”TLY llnd(’T P(lge \S’H’HP ﬂﬂd CI1()()NC [hC
appropriate number of columns.
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Page Seflip [P Paragraph
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o - - pa—
: Calibri (Bady) ~|11 +| A" A" Aa~ =
Paste . A - . = &
- & Format Painter a1, Tl e, 2 O v A
Clipboard 5 Font Paragraph
Links

Word automatically creates a hyperlink when a uscr pastes
afull URL onto a page. These may not make sense to screen
reader users, so more information is needed.

Adding Hyperlinks

1. Select the text you want linked, right click, and select
Hyperlink or CTRL + k.

2. Make sure the text in the Text to Display ficld is a
meaningful description and type the link URL in the

Adedress bar.

T
Edit Hyperlink 7 s |
tinkto: _Textto display: ICDAE Newsletter ScreenTip..
(9 Look in: My Dacuments =] & (@) (@)
Existing File [ & & =) P —
or Web Page Camtasia Studio « | | Bookmark..
Current e —
it Custom Office Templates ——
4] Downloads (et Eamess)|
Pacein This | | g oceg it E
Document ookt e 7
0 9 @ acrobat xi.pdf.accreport.html |
Regent -xi,pdf. Ei
Create [ew i1 &/ acrobat-xi.pdf.accreport.html
Document | Address: | http://ncdae.org/resources/newsletter/ [=] | Bemove Link |
Eailt [ ok ][ cancel
Data Tables

Accessible tables need a clear table structure and table
headers to help guide a screen reader user.

[ ]

95 GOALS
N[}
2.To add table headers to the first row, select Table Tools>

Layout on the ribbon, then choose the Repeat Header
Rows option in the Data section.

© 2014 Project GOALS All rights reserved.

Creating Tables T e
1. Select the Insert tab on the |8 CoverPage- C\} 7
ribbon, then select Table > |2 BerkPeee b e
Insert Table I P Reak Pictures
Pages Tables 1
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Options in the Design tab may be used to change appearance
but will not provide the necessary accessibility information.

Accessibility Checker

Word includes an accessibility resource that identifies

accessibility issues.

1. Select File> Info.

2. Select the Checke
Jor Issues button
and choose Check
Aceessibility.

Info

Protect Document

Control what types of changes

Protect
Document

(3]

. The Accessibility
Checker task pane
will show accessibility
errors, warnings,
and tips on how
to repair the errors.
Select specific issues
to see Additional
Information at the
bottom of the task pane.

Inspect Document

g this file, be aw

Content that people with d

> Inspect Document
= Check ment for hidden propetie:

Other Principles

* Ensure that font size is sufficient, around 12 points.
* Provide sufficient contrast.

L D()n‘t usc C()IC)l' as tl]e Ofll-y wﬂy to C()ﬂ\’(‘)" content.
* Provide a table of contents for long documents.

e Use SiHJPlB ]’Al'lngElg(f.

For a digital version go to nedae.org/resources/cheatsheets




Authoring Techniques for Accessible Office Documents: Microsoft Word 2013

Quick Reference

Technigue 1. Use Accessible Templates

Technique 2. Specify Document Language

Technigue 3. Provide Text Alternatives for Images and Graphical Objects
Technigue 4. Avoid "Floating” Elements

Technigue 5. Use Headings

Technigue 6. Use Built-In Document Structuring Features

Technigue 7. Create Accessible Charts

Technigue &. Make Content Easier to See

Technique 9. Make Content Easier to Understand

Technigue 10. Check Accessibility

Technigue 11. Use Accessibility Features when Saving/Exporting to Other Formats
Other Application Features

Accessibility Help

Go to Usage Notes

"Curb Cuts"

This icon highlights "curb cut” opportunities in these technigues. "Curb cuts” are situations in which accommodations made for
== accessibility reasons will also result in significantly better and more efficient outcomes for everyone. The name comes from sidewalk "curb
cuts” that were added for people in wheelchairs, but are commonly used by people with baby strollers, handcarts, wheeled luggage, and
others,

Technique 1. Use Accessible Templates

All office documents start with a template. These can be as simple as a blank standard-sized page or complex nearly-
eriee £o . . page ercome "~ | WCAG 2.0 Applicability:

All success criteria

complete document with text, graphics and other content (e.g. a "Meeting Minutes" template). Because templates
provide the starting-peoint for so many documents, accessibility is critical. If you are unsure whether a template is

accessible, you should check a sample document produced when the template is used (see Technigue 10. Check

Accessibility).
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+* Creating Accessible Documents with MS-Word

Uploaded by: Georgios Kouroupetroglou, University of Athens, Greece Fated:
Uverview School Context UDL in Action Media Resources Skills and Competencies
Assessment Evaluation / Comments from Users

Resources / Environment:
For this Good Practice users must have access to a personal computer with the MS-Word word processor (version
2007,2010, 2013, or 2011 for MAC).

Barriers and Opportunities:

Applying the MS-Word accessibility guidelines in existing documents, may be time consuming. In contrast, when the
MS-Word accessibility guidelines are applied during the creation of new documents the required extra time is
substantially shorter.

The 2010 and 2013 versions of M5-Word include an accessibility checker tool.




Uploaded by: Georgios Kouroupetraglou, University of Athens, Greece Fated: df  open
Overview School Context UDL in Action Media Resources Skills and Competencies

Assessment Evaluation / Comments from Users

UDL Principle: Learners are engaged and motivated in different ways
Guideline: Different known interests and motivators are addressed such as ...
« choice in context

Guideline: Interests and goal attainment as well as resilience are stimulates actively by ...
« practical relevance

Guideline: There are opportunities for self-regulation provided ...
« creative freedom
+ grganizational flexibility

UDL Principle: Information/instruction offered in different ways
Guideline: Relevant information is available on the learning objectives and outcomes
« inadvance
« atany time
« on demand

Guideline: Information can be assimilated in various ways
« yisual

Guideline: The understanding/comprehending of information is supported by providing various
options

« jllustrations

« practical demonstration

UDL Principle: Allow the learners to express what they know in different ways

Guideline: Learner can actively work with the learning materials in different ways
« individual worl
« group waork

Guideline: Learners ¢an show the results of work as ...
« textual description
« practical demonstration

Guideline: There are different forms ofsuppon FII‘D'I."idEd such as ...
« formative (self) assessment




UDLnet project partners

Ellinogermaniki Agogi (Greece)

Universal Learning Systems (Ireland)

National and KapodistrianUniversity of Athens (Greece)

Agalia Elpidas (Cyprus)

N H L NHL University of Applied Sciences (The Netherlands)

HOGESCHOOL

®
& e ceFAS e.V. (Germany)
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c Spanish Confederation of Education and Training Centres
(Spain)

Enablelreland Enable Ireland (Ireland)

O Finnish Association on Intellectual and Developmental
FAIDD Disabilities (Finland)




i
UDL

Universal Design for Learning

http://udlnet.di.uoa.gr/

University of Athens
‘Department of Informatics




